
 

 

EFPF: European Connected Factory Platform for 
Agile Manufacturing 

 

WP1: Project Management 

D1.1: Project Handbook – Annex - StyleGuide -  
Vs: 1.0 

 

Deliverable Lead and Editor: Usman Wajid, ICE 

Contributing Partners: All 

Date: 2019-03 

Dissemination: Confidential 

Status: Consortium Approved 

  

Grant Agreement: 
825075 

Short Abstract 

This document identifies the writing format, style, and approach that 
must be used by all EFPF deliverables of type “report”. It also 
provides guidance for style use to other documents, presentations, 
and written material. It is an intrinsic part of the EFPF handbook. 
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1 Headings Level 1 

An example of an emphasis box to highlight key aspects when styling. Note this box is a 
table cell since use of word graphic text boxes causes chaos when editing document and 
cut-pasting. Also, by implementing these two points you will resolve 1/3 of all editing pain 
for everyone. 

• Ensure the English (United Kingdom) dictionary is on and periodically do CtrlA (Select 
all) and the from the Review menu select Language, then Set Proofing Language, then 
English (United Kingdom), then untick both checkboxes, the select Set as default and 
press OK. Do this regularly since other will forget to do this and when you paste in your 
document it seems to reset globally 
 

• Go into the File menu and selection Options and then Proofing Options. Check the 
options ‘spelling as you type’, ‘grammar errors as you type’. Under Writing Style select 
‘Grammar and Refinements’ and then select settings and check everything except 
'Complex Words', 'Passive Voice', 'Passive Voice with Unknown Actor'. Finally set 
space between sentences to one 

 

Salient points re headings: 

• Section 1 starts the main body of each deliverable 

• Headings of Level 1 use Style “Heading1” 

• Each heading of level 1 may be followed by either: 

• No text 

• Brief text (3-4 lines maximum) summarising the content of the entire section 
 

• Broadly speaking, either of the approaches should be implemented coherently, but 
uniquely, within a single document 

• In the majority of documents, make use of a maximum of four heading levels. However, 
for certain lengthy documents, for example the Functional and Technical 
specifications, if entirely necessary an absolute maximum of 6 heading levels should 
be used 

• No additional implied headings should be used (e.g. with underlining etc) 

• Do not insert a line break before or after headings 

• All words in headings should be capitalized except for conjunctions, prepositions (e.g. 
on, of, by, and, or, but, from, with, without, under) and definite and indefinite articles 
(the, a, an) unless they appear at the start of the heading text 

• All Annex headings (Style: Annex) should be listed in the table of content 

• Non-listed headings (e.g. Executive Summary) should be formatted the same as 
Heading 1 (Style: S Non-Header), but without numbering, and should not be listed in 
the Table of Content 

• Heading 1 automatically inserts a page break before it 

• The number of each heading always starts at the left margin and the heading text is 
always indented 2cm for every level of heading 

1.1 Heading Level 2 

Headings of Level 2 use Style “Heading2”. 
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1.1.1 Heading Level 3 

Headings of Level 3 use Style “Heading 4”. 

Lorem ipsum dolor sit amet, consetetur sadipscing elitr, sed diam nonumy eirmod tempor 
invidunt ut labore et dolore magna aliquyam erat, sed diam voluptua. At vero eos et accusam 
et justo duo dolores et ea rebum. Stet clita kasd gubergren, no sea takimata Text 

 Heading Level 4 

Headings of Level 4 use Style “Heading 4”. 

Lorem ipsum dolor sit amet, consetetur sadipscing elitr, sed diam nonumy eirmod tempor 
invidunt ut labore et dolore magna aliquyam erat, sed diam voluptua. At vero eos et accusam 
et justo duo dolores et ea rebum. Stet clita kasd gubergren, no sea takimata Text 

1.1.1.1.1 Heading Level 5 

Headings of Level 5 use Style “Heading 5”. 

Headers above 4 levels are highly discouraged. 

1.1.1.1.1.1 Heading Level 6 

Headings of Level 6 use Style “Heading 6”. 

Headers above 4 levels are highly discouraged. 
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2 Bullets 

When to bullet? Listing out simple lines, such as the list of fruit below, is much easier to read 
than a narrative list in a sentence (apple, pear, or banana) but it is not a hard rule, so some 
common sense needs to be applied. It especially depends on ‘emphasis’ since if it is 
important, then perhaps clear bullets are better where as if it is more general narrative then 
a sentence can be appropriate since bulleting also breaks up the reading of potentially 
flowing text. This logic applies especially to where the list are single item words, few words 
or single sentences fitting on 1, max two lines. 

Where the ‘items’ start to become paragraphs (say, >3 lines/sentences), or multi-
paragraphs, the consideration should be given to if bullets are appropriate at all since it 
becomes difficult to navigate especially between bullets and across pages. Bullets should 
not be used where a single bullet would be more than, say, one third of a page. 

Also, consistency is important. The purchase example below shows 3 bullets of 2 lines/2 
sentences, 1 line/1 sentence, and finally 4 lines of multiple sentences. The list just-about 
works in the example below but if the last bullet was any longer it would not, and if the 
first/second bullets would have been only one line it would not have worked either – 
disbalance. So potentially a more narrative approach would have been better 

By default, a list of bullets infers an ‘or’ intention of a list – i.e. that one or more, including all, 
of the bullets may apply. If it is absolutely “all” of them or some other scheme (e.g. ‘a 
maximum of 3’ or each one exclusive) then this should be explained in the header line – e.g.  

Only two of the following can be selected: 

• Apple 

• Pear 

• Banana 

In terms of purchase justification, it is mandatory to do all the following: 

• Provide a detailed specification of the pencil or other stationery item required. This 
should be created on form 26A and any graphics embedded in the document. 

• Get three quotations which must be on headed form/paper by the suppliers 

• Fill in form 57 on both sides remembering to use black ink. Do not forget to fill in the 
department name nor the code number. Email this to the relevant purchasing number 
and provide a copy to your finance officer.  Ensure that you retain a copy for your 
own records 

It is not compulsory that the bullets should ‘make’ a sentence with the bullet header – e.g. if 
the header is “Impact is important:” the following bullets are perfectly valid despite the fact 
some sentences are not formed with the header – “Since research without impact is 
irrelevant”, “Tax payers expect results” (i.e. it doesn’t have to be: “Because Tax payers 
expect results”) 

The following shows an example for how to format bullet points: 

• Bullet Headers: 

• Always introduce a list of bullets with a bullet header using the standard 
paragraph style (and thus has addition ‘after paragraph spacing’) and end the 
header with a colon (:). This applies to the start of the list of level 1 bullets and 
any sub-bullets 

• The level 1 header starts at the left margin 
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• Bullet headers have 6pt of spacing after them the same as normal paragraphs 

• Never fix the number of bullets: i.e., do not say “This is summarized in the 
following two points:”; instead, use “This is summarized as follows:” (just in case 
bullets are added and you forget to change the ‘two’) 
 

• If you find yourself writing i) …ii) in a paragraph or start writing a comma separated 
list…then invariably it is better writing bullets to be clearer 

• Do not use sequential bullets (1, 2, 3…a, b, c) UNLESS there is a real need; e.g. 
because it is a step of a process. The same rules as for normal bullets also applies for 
sequential bullets 

• Use solid round bullets for ALL levels; e.g.: 

• For level 1 bullets: 

• For level 2 bullets: 

• For level 3 bullets 

• 1st level bullets align with 2nd level text (such as in this example): 

• 2nd level bullets aligned with 3rd level text 
 

• Bullet Wording: 

• Capitalize first words (unless first word is specifically un-capitalized; e.g. vf-OS or 
ebXML) 

• If there is consistency in the text at the start of the bullets keep it that way; e.g. if 
all the bullets begin with ‘To’ then do not have one beginning with ‘When’ – 
however inconsistent bullets are fine 

• Ideally the first word of the bullet should be an important one rather than adding 
words like “the”, “a” etc 

• Bullets can have an emphasised bold first few words; but not too many and it 
should be consistent (e.g. every bullet in that list may have one); e.g.: 

• Deliver: To… 

• Purchase: When a…. 

• Invoice: In the case… In these cases, note the capitalisation after the 
colon and the soft-line break following (see bullet spacing below) → 
 

• The following is also possible (e.g. two sets of colons): 

• Section 1: Purchasing: When a…. 
 

• Bullet Spacing: 

• Bullets are spaced at the 1cm markings (1, 2, 3,) on the ruler (just like headings) 

• Do not use line spacing between bullets of the same level – set to zero as in this 
template 

• Insert a soft-line break (Ctrl-Enter) in between bullet list levels at the end of 
bullets. For example, in the previous second level bullet list there is a Ctrl-Enter 
after “In the case…” 
 

• Bullet Separators: 
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• For bullet terminators (periods, semicolons etc.) as a default usually leave them 
blank (e.g. as typically performed in PowerPoint) and especially for a “pure” listing 
where only single terms or half-sentences or headings are listed.  

• However, for exceptionally long bullets having no period at the end of the last 
sentence can look odd although the only systematic way around this is to put a 
period on every bullet or add further rules so it can also look complex/messy. So, 
even though there is some ‘oddity, IF the bullets are generally ‘paragraphed’ 
sized end terminated should be included on ALL bullets in that heading 
regardless of size. This set of bullet applies this rule. 

• The problem comes where there is a mix of bullets in the same list – e.g. three 
single items of one line followed by one bullet of 10 lines. In general, such cases 
should be rare since bullets should be of comparable size, but if it is the only the 
solution judgement should be ‘on balance’ – in this case most bullets (3) are 
single so no final punctuation on the long bullet. Looking at this specific list, it can 
be seen that that the balance of the list is paragraphs and so the final two short 
sentences have also been terminated. 

• End the list of bullets with a normal line break (enter). 

• Continue with text formatted using paragraph style. 
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3 Style of Standard Formatted Text 

Notes regarding the style of standard formatted text: 

• Styling: 

• Use the styles provided for headings, lists, text body and which are on the word 
Home menu (generally), … 

• When drafting documents if there is text which is not complete or missing always 
put it in yellow or with a bubble comment. If not, it is too easy to forget it – of 
course take the yellows out at the end as one of the final checks 
 

• Spacing and Breaks: 

• Use the paragraph line spacing – do not change this by using additional hard-line 
breaks (<Enter>). By default, this is set as 1 and with 6pts spacing after the end 
of each paragraph 

• Do not insert an additional line break before or after headings 

• Wherever possible try not to use landscape 

• Always single-space (vs double) after end of sentences. If “” implies a space, 
then single spacing would be “…blah.Purchasing rule 59 states…” but double 
spacing would be “…blah.Purchasing rule 59 states…”. This can be pre-set 
in the options of word 

• The is also a single-space after commas, semicolons etc 

• If a sentence is more than 3 lines long, it should be split. Even 3 lines is an 
exception – generally for readability they should be 2 

• If you have a list always comma every item and end the list with an “and” or an 
“or”. i.e. rather than “Stuart, Oscar, Tom”. Or “Stuart, Oscar and Tom”. Use: 
“Stuart, Oscar, and Tom”. This is called the oxford comma and is an option 
available in word 

• When cut and pasting from emails there are often hidden hard spaces inserted 
which in format mode is small circles separating words. Ensure these are 
removed 
 

• References: 

• Try not to use footnotes since it reduces readability – however in some cases this 
is unavoidable such as URL references. But if you find yourself with more than 
say 2 footnotes on a page consider using the reference page in the Annex which 
in any case is preferred 
 

• Emphasis: 

• Do not emphasise (i.e. picking out words in e.g. bold you want to stress) too much 
if at all. There is a tendency to do it inconsistently in the same section or specific 
emphasised sections can look odd. In addition, often over-emphasis is applied 
with the emphasis being words that are not bold! If more than one person is 
working on the document often everybody will make use of emphasis in a different 
way thus better not to use at all 

• However, emphasis of the first words in bullets (see Bullets section) is ok if it is 
consistently performed 
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• If you want to emphasise something, make use of Bold. For emphasis never use 
italics, underscore, capitals (see below), or a larger font size 

• Capitals may be used for very strong negative emphasis – e.g. BE CAREFUL 

• However, highlighting certain words italics may be applicable: e.g. “When pasting 
in images from Excel, PowerPoint etc. e.g. “use Start → Paste → Paste Special 
→ Paste as Enhanced Metafile“ 

 

• Text justification: 

• All paragraph (normal) text to be justified  

• All bullet lists should be justified  

• In tables: 

• Text should be left justified except table heading text, which should 
(generally) be centred 

• Numerals should be right justified 
 

• Font: 

• The only font to use is ARIAL except for code/XML etc where snippets with 
CONSOLAS font can be used 

• Main text is always size 12 

• Headers vary between 12 and 17 

• In tables only: 

• Size can be 12 or 10 (although always 12 for headers) 

• In exceptional tables size can be 8 (never smaller) 
 

• Other: 

• This “–” is a dash; this “-” is not, as it is a hyphen. If you want to make use of a 
dash such in the last item of this listing, use the right symbol 

• Cells in tables should never be blank; if there is not a logical entry then insert 
‘N/A’ (or similar) since else it can infer to the reader something is forgotten 

• If the pagination makes the list difficult to read, then insert line breaks (for 
example if ‘font’ (above) would be on the previous page and all bullets would be 
on the next it does not read well; thus, insert line breaks to include on the next 
page. However, this should only be performed at the end of the document editing 
process 

• Do not embedded numbered lists in sentences; use bullets. I.e. NOT “this 
includes: i) xxxx, ii) yyyy, iii) zzzz”  

• Typically, in bullets where three are bold initial words and have a colon. The 
following sentence should have an initial capital letter. I.e. NOT “Activities: buying, 
selling” …. BUT “Activities: Buying, Selling”: 

• Activities: buying 

• Activities: Buying 
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4 Spelling, Grammar, and Acronyms 

4.1 Spelling and Grammar 

Notes regarding spelling and grammar: 

• Turn on word spelling and grammar!!! 

• Do not use personal words such as “we”, “his”, “she”, “he”, “they”, “you” etc. Always 
rephrase to the impersonal; i.e. “We analysed the user experience” to “The user 
experience was analysed”. An exception is the use of the personal in quotations.  

• Ensure the text language is set to UK/British English and spell/grammar check against 
this at every step. Even if in the DOA a word is in e.g. American English for simplicity 
and coherency still use UK/British English in all documents; example of use: 

• Colour not Color,  

• Centre not Center, Standardisation not Standardization 
 

• Be aware Microsoft Word has a habit of re-setting language options on documents so 
always check this 

• Be careful of sentence fragments: e.g. “Exchanging their role from passive and 
unidirectional to proactive and interactive.” 

• Use “…” (3 dots) to infer a list extension (or use etc) 

• Use “i.e.” and “e.g.” and always in lower case – the reason for this is that people 
invariably do it in many ways and this simplifies to the most simplest 

• Use “etc.” and not “etc”  

• When using “/” as a ‘or’, for example “Yes / No” ensure a space before and after the 
slash – i.e. NOT “Yes/No” 

• When it is wished that certain wordings are not split across lines by Word – utilise hard 
spaces which is achieved by Ctrl-Shift-[ SpaceBar ] vs normal spaces. E.g. Form C 

• Do not write in the future tense: i.e. NOT “EFPF will be a project about…” →”EFPF 

is…”, “section 5 will discuss…” → “section 5 discusses” 

4.2 EU Speak 

The following EU-type terms use is relevant: 

Term Valid Use Invalid Use 

Work Package • Work Package 

• Work Package13 

• Work Package13(“Impact”) 

• work package 

• WP13 

• WP13.1 

• Work package 

• Workpackage 

• WP1 

Task • Task 

• Task1.5 

• T1,5 
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• Task1.5(“Data 
Acquisition…”) 

• T5.1 

• T5.1.2 

• T5.1.2a 

• T5.x (meaning Tasks of WP5) 

• T5.1/4 (meaning Tasks T5.1 
and T.4) 

 

 

4.3 Acronyms 

Acronyms: 

• The project’s URL is: www.efpf.org  

• Use DOA as abbreviation for the Document of Action (Do not use DOW) 

• Use BOP as abbreviation for the Board of Partners  

• The acronym of the project is always “EFPF” in exactly this casing construct. It is never 
eFPF, EFPf etc 

4.4 What’s in a name? 

Note the following re EFPF use: 

• When referred to in text (documents, ppts) and formally where the legal name needs 
to be used, the name of the project should be European Connected Factory for Agile 
Manufacturing 

In all of this note: 

• Never European connected factory platform for agile manufacturing, European 
connected Factory for agile Manufacturing…. (aka capitalisation) 

• Never EFPF for Agile Manufacturing, EFPF Manufacturing Platform (aka full name or 
full acronym – never a mix) 

• Always Platform…never Pilot, Project, Prototype 

4.5 Term Capitalisation 

The following common terms are capitalized: 

• Section (only as in “see Section N.N”) 

• Work Package (NB NOT Workpackage) 

• Task 

• European Commission 

• European Union  

• Users, Technology Providers, Consultants and Research Institutes  

• European Connected Factory Platform for Agile Manufacturing 

• Software Development Kit  

• Software Developers  

http://www.efpf.org/
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• Service Providers  

• InCloud, OnPremise, and InCloud/OnPremise 
 
NB  In general, terms should not be capitalised unless they are acronyms or warnings. 

4.6 English 

The following are grammar issues typically (and are picked up in word): 

• done → performed, made, created 

• and also → and 

• in order to → to 

• Composed by → composed of 

• due to the fact that → because, since 

• don’t → do not 

• doesn’t → does not 

• adhoc → ad hoc 

• Massively 

• Vastly 
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5 Images  

5.1 Images 

The following notes apply to images: 

• Image captions placed under the figure are (broadly) mandatory and should be of the 
form “Figure X: Abc abc” where X is the consecutively number and a figure reference 
(field code). The caption must be centre justified and under the diagram; font size is 
12, Arial, non-italic 

• The exception is where clearly it is for market purposes – for example, the graphic in 
section 0.1 of this document 

• Captions should be inserted selecting the image and using the option (References → 
Insert Caption) 

• Position of the image: Generally, this should be positioned either at the top or bottom 
of a page or directly beneath or above a header. Although it can depend significantly 
on the type of image and the text context. 

• Images should, where possible, always be close where it is referenced for the first time. 
Whether this is before or after the reference is at the authors discretion as it depends 
heavily on the context/layout although the preference is for placement after the 
reference 

• Make sure that the figure is readable even if printed in black or shades of grey 

• If there are several figures in a document, e.g. showing architectural aspects, class 
diagrams, or similar structures in general, they should have a similar “look & feel” and 
in general be aligned with the ‘hues of EFPF (blue, light blue) 

 

Figure 1: Example Image 

5.2 How to Insert Images 

When pasting in images from Excel, PowerPoint etc. use Paste → Paste Special → Paste 
as Enhanced Metafile and set the layout properties to “in-text” since this allows better and 
easier reformatting and stops other content of the file being carried forward. For example: 

• Step 1: Copy an image from PowerPoint or Visio using Ctrl+C 

• Step 2: Click on the small arrow symbol on the paste button and select “Paste Special”: 
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Figure 2: Paste Button 

• Step3: Select “Picture (Enhanced Metafile)” and click on “OK” 

 

Figure 3: Paste Special Window 

• Step4: Your image will be inserted 

 

Figure 4: Example Image 
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5.3 Image Style 

The image below shows good practice on the use of colours and imagery within EFPF 
documents. 

 

Figure 5: Example Image 
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6 Tables 

The following applies to tables: 

• Table captions: 

• These are also called ‘Figures’, are placed under the table and are mandatory 
and should be of the form “Figure X: Abc abc” where X is a consecutively number 
throughout the document and inserted as a figure reference (field code) from the 
appropriate menu (or cut paste from a previous figure) 

• EFPF classes both images and tables as ‘Figures’ 

• There is no table of Figures listed at the front of a document only a contents page 
of the first 3 levels of headings 

• The caption must be centre justified and under the diagram; font size is 12/10/8 
(less preferred), Arial, non-italic 

• They should be inserted selecting the table and using the option (References → 
Insert Caption) 

 

• Position of the table: Generally, this should be placed either at the top or bottom of a 
page or directly beneath or above a header 

• Header row (and possibly the first column): 

• Should have a blue (EFPF) background and be white bold text generally centred  

• The font type and size should be the same as in standard text 
 

• Every other columns (cells) (beside of the headers) should be aligned to the left – do 
not use full justification in tables since it tends to look very bad 

• Make sure to add an empty line before the table and there is sufficient spacing after 
the figure number 

• The font in tables should generally be 12 as well but 10 is ok and if really necessary 8 
as well 

• In tables the bullet indent can be decreased from 1cm to 0.5cm 
 

Figure 6: Example Table 

Lorem ipsum dolor sit amet, consetetur sadipscing elitr, sed diam nonumy eirmod tempor 
invidunt ut labore et dolore magna aliquyam erat, sed diam voluptua. 

Heading 1 Heading 2 Heading 3 

[Optional Subheading – 
NB most likely the cells 
here will merge] 

  

Example text in Point 10 Even more example You will not believe it! More 
example text! 

Another example Still another example An example with bullet indent 
reduced from 1cm to 0.5cm 

• A 

• B 
• C 
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7 Referencing Images/Tables/Headers 

 

Figure 7: Example Image 

When referencing figures, tables, or headers, make use of, e.g. “(See Figure 1: Example 
Image)” or “As can be seen in Figure 7…”. For any type of reference please always use the 
References/Cross References feature of Word. This will allow automatic updating of these 
references if moved or new tables/images/sections are inserted and clicking on the 
reference will jump to the referred image, table, or header. 

As a rule, it is good to reference figures in text (“we can see in Figure X” instead of “in the 
table below”). However, if you use words referencing you can also get word to auto-insert 
either ‘above’ or ‘below’, such that any movement of the figure means the text is auto-
adjusted, and this is acceptable. 
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8 References 

8.1 Citations 

EFPF will make use of the IEEE Reference Style Guide, which can be found at: 
http://www.ieee.org/documents/ieeecitationref.pdf. 

However, there is one especially important exception – EFPF will not make use of numbers 
as proposed by the IEEE. The actual cite to a referenced document is created out of the first 
letters of the first three authors and the last two digits of the publishing year. If there is only 
one author, the first three letters of the author’s name are used. If there are two authors, the 
first letters of the two authors’ names are used. If there are more than three authors, a tailing 
+ must be added between authors and the year. If the two references are the same, insert 
A, B, C after year to differentiate. 

References are sorted alphabetically. The actual reference list is at the end of a document 
are font size 12. It starts at a separate page. Examples are below and you will find more 
examples in the linked IEEE Reference StyleGuide. 

Example: 

“TST+13” for “Tolio, T., Sacco, M., Terkaj, W., & Urgo, M. (2013). Virtual factory: An 
integrated framework for manufacturing systems design and analysis. Procedia CIRP, 7, 25-
30.” 

Note that since text may be cut paste from many editors these references are thus 
hardcoded and do not use Word reference mode since using this tends to cause ‘reference 
not found’ errors when cut-pasting. 

8.2 Cross Referencing 

When referring to different sections of a document always use Words Cross-Referencing 
facility on the References menu. Also insert at-least the Number (e.g. Section Number 
“Section 1.1”). The Heading is optional and should be separated with a hyphen (e.g. “Section 
1.1 – Heading”) 

 

http://www.ieee.org/documents/ieeecitationref.pdf
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9 Common Errors 

• Each partner uses the bullet points in different forms. The partners should follow 
Section 2 of EFPF StyleGuide Document 
 

• Not using properly headed (introduced) bullets! → Partners should follow the Section 
3 of EFPF StyleGuide Document 

 

• Not using bullets starting with capitals, or (short) bullets erroneously contain end 
terminators, or use of non-solid round bullets 

 

• Do not use personal style. e.g. “We”. Always rephrase to the impersonal. The partners 
should follow the Section 4 of EFPF StyleGuide Document 
 

• Do not use italic or underline to emphasise. Use bold instead to emphasize. The 
partners should follow the Section 3 of EFPF StyleGuide Document. Use italic for 
people or entities quotations, e.g.. Charles Darwin said “italics text blah blah...” 
 
 

• The words in headings should be capitalized. Each partner uses different forms. The 
partners should follow the Section 1 of EFPF StyleGuide Document 
 

• Text justification should be “Left”. The partners should follow the Section 3 of EFPF 
StyleGuide Document 

 

• Bullets (level 1) are aligned with the left margin (do not indent). For example, in this list 
the bullet character is aligned with the “9” of the Section number 
 

• Single space after sentence terminator (period) and not double. Tip: Perform a 
Find/Replace of double to single space BUT check each instance – do not perform a 
‘replace all’ 

 

• Check the glossary for the use/capitalisation of terms. Note the capitalisation on 
Section (as in See Section XYZ), Task, Work Package etc 

 

• You havn’t screwed up the page numbering or the footers. The pages before section 
0 have their own numbering in Roman Numerals (I, II, III…) and thereafter in Numerics 
(1, 2, 3…). The two sections are no continuous in terms of page numbering 
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10 Pre-Submission / Review / at Major Stages 

Pre-submission check: 

• Turn off Track-changes if they are on 
 

• Select all text and press F9 (Update all fields) at least twice (to update the TOCs as 
well) 

 

• Select all text and ensure language of text is English UK (United Kingdom) 
 

• Ensure final document is spelling and grammar checked 
 

• Check Cover page, Contents, intro page etc are complete and logical 
 

• Check that “Section 0 Introduction” has been inserted and changed in-accordance to 
the content of the deliverable 

 

• Check the pagination in the footers is logical and that the images in the first/last pages 
and footer/header is not distorted 

 

• Regenerate Contents pages and ensure no “bad references” are there or in the rest of 
document (Search the text for “Error! Reference source not found.”) 
 

• Check all redlines (track-changes) are accepted and comments deleted, and yellows 
removed 
 

• Check document prints ok in black and white; fits to pages etc. 
 

• Check the PDF file Generates properly - check all page 
 

• Do a hunt for “error” to make sure there are no reference errors (double check!) 
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11 Template Use 

The EFPF template document must be used for all EFPF  

reports and documents either informal or formal. 

Before starting a new document, it is significantly better to use the template as the basis 
from the start rather than cut paste text into it later since pasting will often overwrite elements 
(e.g. footer) which will take an editor considerable time to fix. 

On this basis the following steps are necessary when commencing a new document: 

• Open the document and save under the new document name 

• Remove any comments in the template 

• Complete all the fields in yellow on the cover and second page and when each is 
complete, remove the yellow colour from it. See also notes on StyleRefs below 

• Select the whole document (CtrlA) and press F9 to refresh the fields which should then 
auto-populate the header/footers and the table on page 2 

• Any grey notes which are ‘complete’ or ‘invalid’ remove as you go 

• Complete the yellow text in executive summary and Section 1 for the deliverable. You 
can use this document as guidance 

 

The yellow items on the cover page need to be edited with care. The <> and text within the 
<> should be edited/overwritten but not any other text. For example, the relevant WP Title 
(e.g. “Impact”) should be typed over <WP Title> but the colon and “WP” should not be edited. 
<WP Title> is labelled as a specific style, for example "WPTitle". Once formatted in this style 
then the information (e.g. “Impact”) is then automatically picked up and auto-entered in other 
parts of the document (e.g. status table and footers). This ensures these styles remain 
correct and must only be used once else the last text occurrence will be picked up. To see 
which style a text is, right click on it, select style, then you will see it highlighted. To apply a 
style in case of mistake select the relevant text, go to the home menu. Look at the long styles 
box (scroll as necessary) and then choose the style. Relevant styles are: 

• WPID & WPTitle 

• DelID & DelTitle & DelVs 

• DelLead 

• DelDate 

• DelConf 

• DelStatus 
 

NB you may need to press F9 to propagate changes to other fields and even do CtrlA and 
do F9 - they are best seen on next page. 

For segments of the document which picket up these styles, e.g. the footer shows the 
deliverable title, words fields facility is used and the Styleref field – which picks up relevant 
styles. Such fields are locked so that they are not over written. 

Other fields are locked simply because they should not be changed – for example headers 
and certain text of Section 0 or the partner logos. Locking prevents the editor ‘misapplying’ 
or ‘damaging’ the ‘delicate’ field codes in the template/word but conversely in some 
circumstances can cause problems to edit so there are some work-arounds. 
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In theory there should be no need to change this locking but in an ‘emergency’ you should 
do the following: 

• See if it is a field code by toggling AltF9…if it is it means it pickets up information 
elsewhere in the document aka the cover page via hunting for the style (see below) 

• Go to File→Options→Customize Ribbon and then in right hand section tick the 
developer option which gives you the developer tab on the main ribbon. Select OK. 
Then from the developer tab select restrict editing and in the pane that pops up select 
stop protection to the bottom of the screen with password “EFPF” 

 

In case the footer page numbering becomes damaged please refer to this URL: 

• https://gregmaxey.com/word_tip_pages/page_numbering.html 
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12 FAQ 

Follows is a common list of issues in the template: 

Issue Comment 

Yea Gods Usman!...isn’t 
this overkill? 

No. Its: 

• Professional 

• Coherent 

• …and above all efficient…think about if you are an 
editor of a document or an internal review of a 
document and you see all the varied input…think of the 
time wasted and/or perception of the document. If the 
document is not good…how good can the real 
deliverables be!!! 

The page numbers on 
the document are all 
wrong 

It essential that you formulate the sections and the footers 
and the linking exactly as in the template. Notably that 
everything up to and including the contents page is 
header/footer Section 1 (i.e. a section page after contents 
page) and that the footers fields (i.e. the name of the 
document and page numbers) are copied from the template 
since they perform calculations to e.g. extract the initial pages 
marked with pagination in roman characters. You can see the 
field codes by Alt F9 

The tables split oddly 
across pages 

Change the cell font to ‘Body Text’, reformatting (e.g. 
changing size) as necessary afterwards 
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Annex A: History 

 

Document History 

Versions 
V0.01-2: 

• First Draft (95%) produced by Editor/Coordinator 
 

V0.03-4:  

• Minor Editorials 

Contributions 
ICE: 

• Usman Wajid – Entire Document 
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Annex B: References 

E.g. [Waj05] U. Wajid, “Reconciling Content Syndication and…. 

 
ONLY use THIS referencing format…see style guide for details 

[Further Annexes if needed]
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Landscape Example 

http://www.efpf.org/
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